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OVERVIEW 
OfficeView is a program that shows the whereabouts of employees at the glance of a screen.    Easy to 
use and install, it will prove useful in any office where people are coming and going during the day.    The 
reception desk can respond quickly without having to make phone calls or searching for available 
employees. 
 
OfficeView has an easy to read display board.    Employees that sign in are highlighted in green (in and 
available) or in purple (at work, but unavailable).    A simple click of the mouse can change someone’s 
status.      Users may choose a remark from a list of standard remarks describing the employees status, 
e.g., on vacation until <date>, in a meeting, etc., or they may type a customized remark.    Smart fields for 
times, dates or customized prompts can assist you in generating remarks.    
 
If the list of standard remarks does not suit your business requirements, you can easily tailor them to suit 
your needs.
 
Another feature is the messaging system, allowing users to communicate with each other.    Your 
receptionist may find the telephone messaging notes particularly helpful. 
 
An additional information screen is available for each employee.    It contains optional fields of information,
such as: telephone, fax and pager numbers, title, and an easily updated notepad.
 
A password system restricts access to administrative commands that change the configuration.
 
Optional helpful pop-up hints (yellow background) guide the user.    More detailed help is also available in 
the Help menu. 
 
OfficeView may be used on a single computer at a reception desk or on a network, in which case the 
employees themselves would make the entries.    The program is available in four sizes which will 
accommodate up to 10, 30 300 or 1000 names.
 
The 300 and 1000-names sizes have additional features, such as: the grouping of employee names into 
organizational units, e.g., divisions, and the quick search method to find names instantly.
 
 A five-names trial version is available for the 10 or 30-names programs.    The trial version for the 300 and
1000-names programs enable three names in three groups to operate.  You must register your program 
to increase the number of names.
 
For the latest version see http://www.capitalnet.com/~phillips/.
 
 
 
 
 



Easy Access to Hidden OfficeView Screen
If the application you are working in covers the OfficeView screen, you can quickly flip to it by holding 
down the Alt key and tapping the Tab key until the OfficeView icon is selected.    Release the Alt key to 
pop up the OfficeView screen.    Repeat the same procedure to return to your original application.
 
 
 
 



Password Access
 
A password system is available to control access to change some information.    Specifically, this refers to 
using the following commands: Add Name, Remove Name, My Name, Add New Group, Rename 
Group, Delete Group, as well as changing information in other employees' Information windows.    
 
Most users operate in User Mode which prevents them from accidentally adding or removing names, etc..
Administrative mode permits access to use all commands.    To operate in Administrative Mode,    the 
Administrator(s) need only click on File/Admin Mode and enter the password.    To disable Administrative 
Mode, click on File/User Mode.    The unregistered OfficeView defaults to Administrative Mode, permitting
you to easily explore all the features.    The registered copy defaults to User Mode.
 
To change the password, click on File/Change Password and you will be prompted to enter the current 
password once, and the new password twice.    Passwords must consist of letters only.    The program will 
confirm that a new password has been accepted.
    
Initially, the security password is set to "abc".    When you register you will be given an additional 
emergency password.



Adding New Users
To add a new name to the display board, click on Add Name in the Options menu.    Type the new name,
and choose OK or Enter.    The names are automatically displayed alphabetically.

This command is password protected. See Administration.
 
Also see
Unrestricted Access to all commands
 



Associating a Name With a Workstation
The program must identify names with workstations in order to make the messaging system fully 
functional.      To do this, select Admin Mode by clicking on File/Admin Mode.    For each name, at the 
appropriate workstation, click on the name to be associated with that workstation and select My Name 
from the pop-up menu. The name will appear in the top title bar.    This procedure need never be 
repeated, unless a new user operates at that computer.
 
 



Removing Users
To remove a name, click on the name to be removed.    From the pop-up menu which appears, click on 
Remove Name and confirm the removal by choosing Yes.

 
Also see
Unrestricted Access to all commands
 
 



Signing In
 
To sign in, click in the remarks field beside your name and choose IN from the pop-up list.    Your remarks 
field will indicate    IN and the background will change to a green colour.
 
If you want the program to automatically indicate IN beside your name when you turn on your computer, 
then include the program in your Windows Startup group.
 
After signing in, if you do not wish to be disturbed, click on the remarks field beside your name and select 
In But Unavailable from the pop-up list. This remark will appear beside your name and the background 
will turn to purple.
 
 
 
 



Signing Out
To sign out, click on the remarks field adjacent to your name.    A pop-up list will appear.    Click on the 
appropriate comment to assign it to the remarks field.
 
Some of the remarks contain “smart” fields which are identified inside {} or <> brackets.    Remarks with 
the word “time”    in uppercase or lowercase inside {} brackets automatically insert the current time in the 
remark.    Prompts appear inside <> brackets.    Prompts ask for information, such as a future date or time.
 
If the remark you want to insert is not available in the list, then you may enter a customized remark.    
Click on <Custom Remark> and type your remark.    <Custom Remark> is a temporary remark.    If you 
want to insert a permanent remark to the master list of remarks, use Add.    Remarks on the list may also 
be permanently added and deleted using the procedure outlined in Maintaining the List of Remarks.
 
Choosing a sign-out remark turns off the highlight in your remarks field.
 
If you choose Sign Out on Exit in the Options menu, then whenever you turn off your computer and your
remark is indicating IN, the remarks field will automatically change to OUT.    The absence of a tick mark 
in front of this item indicates that this feature is turned off.    Clicking on Sign Out on Exit    toggles this 
feature on and off.

 
 
 



Changing User Remarks
To change a remark, use the same procedure described in  Signing In or Signing Out.    More detailed 
remarks can be inserted in the Additional Information screen.
 
Also see
Signing In
Signing Out
Maintaining The List of Remarks



Maintaining the List of Remarks
 
The list of remarks is the list from which users may select a remark.    To modify this list,    choose Modify 
Remarks List  in the Options menu.    A window containing the list of remarks will appear. This list may 
be updated using the three buttons that appear (Add, Remove, and Close).    To add a remark to the list, 
click on Add and type a remark. To remove a remark from the list, select the remark to be deleted and 
click on Remove. To close the pop-up window, click on Close.
 
Remarks can have a “smart”    field which prints the current time.    To add a remark with the current time, 
insert the word “time” in uppercase or lowercase within {} brackets.    For instance, type “Left at {current 
time} “.    The current time will be printed in the remark when the users choose it. 
 
A second type of field is the prompt field which requests the user to add information.    To add a prompt to 
a remark, insert the prompt text within <> brackets.    For example, include    <date>    to prompt the user to
enter a date. The user can add as many smart fields as they need.    
 
If    the master list of remarks becomes modified extensively and you want to reset it to the original set of 
remarks provided by this program, choose File and Load Standard Remarks.
 
 
 



Sending Messages
 
To send a message, click on the name of the person to whom you wish to send a message.    From the 
pop-up menu, select Send Message.    This action opens a dialogue box where you may type your 
message.    All the standard Windows editing features apply.    If a phone message is to be sent, press on 
Phone Msg and type replies to the prompts for the name and number.    Press Send to send the message
and exit or press Cancel to delete the message and exit.
 
Also see
Reading Messages



Reading Messages
 
A blue flashing background on your name indicates a new message has been received.    To read your 
message, click on your name.    From the pop-up menu, select Read Message.  This opens a dialogue 
box which displays a message as well as the date and time it was sent and the author.    You may click on 
the Erase button to delete the message or click on Next to view the next message.    Messages which 
have not been read are coloured green for the first viewing.    They will be coloured black for any 
subsequent viewings.    Clicking on Erase will delete the message from the queue and bring up the next 
message.    Clicking on Erase All will erase all the messages in the queue.    Clicking on Close will exit 
you from the window.    Upon exiting the window, the background on your name will no longer flash if you 
have read all your messages.
 
The program must identify names with workstations so that users can read their messages at their 
workstations.      To do this, click on the name to be associated with that workstation and select My Name 
from the pop-up menu. The name will appear in the top title bar.    This procedure need never be 
repeated, unless a new user operates at that computer.    The  My Name command is password 
protected.    See Password Access.
 
also see
Pop-up OfficeView
 



Notification of Message Received
 
If a new message is received when OfficeView is hidden by another program window or is in an icon 
state, it will pop-up in its normal size in front of all other windows.    The background of your name will 
flash and the Title Bar will blink    “MESSAGE”.      If you do not want to read the message at that time, then
minimize OfficeView.    If you wish to read your message, click on Options/Read    (or short-cut Ctl R).
 
If you choose to minimize OfficeView without reading your message, the text on the icon will blink 
“MESSAGE” to remind you that a new message was received. 
 
See also
Reading Messages
 
 
 
 



Updating the Additional Information Window
You can change the information in your Additional Information window, provided your name appears in the
top title bar.    (If your name does not appear in the title bar, then refer to Administration    (paragraph on 
associating names with workstations)).    To update the information in the window, click on your name and 
Information and make the changes.    This screen can be viewed by any users.    



Hiding the Yellow Pop-Up Help Hints
 
To prevent the yellow pop-up help hints from appearing, choose Yellow Hints under Options.    The 
absence of a tick mark in front of this item indicates that the hints are turned off.    Clicking on Yellow 
Hints toggles this feature on and off.
 
 
 
 
 



Hiding the Name Warning
 
The question,    "This is not your name.    Do you want to proceed?" appears when a user chooses a name
other than his/her name.    To turn off this warning, choose Name Warning under Options.    The absence
of a tick mark in front of this item indicates that the question is turned off.    Clicking on Name Warning    
toggles this feature on and off.
 



Enlarging or Reducing the OfficeView Screen
 
The OfficeView screen may be enlarged or reduced in steps of 60%.    The screen can be blown up so 
that it is visible from a distance.    To resize the screen, click on Options/Shrink Screen or 
Options/Expand Screen.    You may find it more convenient to use F4 to shrink or F5 to expand.
 
 
 
 



Using Group OfficeView
 
(Included in program for 300 or 1000 names)

Searching for a Name 
Type in the first few letters of the name.    As you type, the cursor will automatically scroll to 
the name in a pop-up screen containing an alphabetical list of names.    This list contains all 
names in the organization (not limited to the employee's group).
Displaying a Group
To display an organizational group, select Group and the name of the group to display.

 The following commands are password protected. Refer to Password Access.

1) Adding a Group
To add the name of an organization/group, choose File/Add New Group.    A window will 
appear indicating "Enter New Group Name".    Type in the name and click OK.
 
2) Adding User Names to a Group 
The group must be chosen before adding new users.    You must be viewing the group; that 
is, the name of the group should appear in the top title bar. The commands for adding users 
to groups operates the same as outlined in Adding New    Names.
 
3) Renaming a Group
To rename an organizational group’s title, select the name of the group to be modified by 
clicking on Group and the name of the group.    This name will appear in the top bar of the 
screen.      Choose File/ Rename Group.      A window will appear indicating "Enter New 
Name".    Type in the name and click on OK.
 
4) Deleting a Group 
 To delete a group and erase all the names in that group, select the name of the group to be 
modified by clicking on Group and the name of the group.    This name should appear on the
top bar of the screen.    Then choose File/ Delete Group.    A window will appear asking to 
confirm that the group should be deleted.    Click on Yes.
 
Also see
Admin Mode
User Mode
 



Searching for a Name
 
 (Included in program for 300 or 1000 names)

This feature provides a fast method to locate a name.    Type in the first few letters of the name.    As the 
name is typed, an alphabetical list of names will pop-up on the screen and the cursor will be automatically
scrolled to the name with matching letters. Type Enter to switch to the group containing the name that is 
highlighted.    This feature will search all names in the organization.
    
 
 
 



File Menu
 
The file menu contains the following commands:

a) Load Standard Remarks
This command allows you to overwrite the existing remarks with a set of standard default remarks.      You 
may use this feature when the list of remarks has been modified and you wish to return to a standard set 
of remarks.    

b) Admin Mode
This enables the user to change the configuration, i.e., add names, delete names, etc..    Initially, the 
Admin Mode password is set to 'abc'.
 
c) Change Password
This enables the user to change the password to access Admin Mode. You will be asked to enter the 
current password once and your new password twice.    Initially, the security password is set to 'abc'.

d) User Mode
This disables commands that allow    users to change the configurations, i.e., add names, delete name, 
etc..

e) Add New Group (300 and 1000 names only)
This command is password protected. Refer to Admin Mode above. Choose this command to add a 
group.    A window will appear with the prompt "Enter New Group Name".    Type in the name and click on 
OK.

f) Rename Group (300 and 1000 names only)
This command is password protected.    Refer to Admin Mode above. To rename the title of a group, 
select the name of the group to be modified by clicking on Group and choosing the name of the group.    
This group name should appear on the top bar of the screen.    Then choose File/ Rename Group.    A 
window will appear indicating "Enter New Name".    Type in the name and click on OK.

g) Delete Group (300 and 1000 names only)
This command is password protected.    Refer to Admin Mode above. To delete a group and erase all the 
names in that group, select the name of the group to be deleted by clicking on Group and selecting the 
name of the group.    This name should appear on the top bar of the screen.    Then choose File/ Delete 
Group.    A window will appear asking to confirm that the group should be deleted.    Click on Yes.

g) Exit
Quits OfficeView
 
See also 
Manipulating Groups
 
 
 



Group Menu
 
To view a group, choose Group in the menu bar.      A list of organizational/group names will appear.    
Choose the desired group.    The screen will display the names in that group and the title bar will indicate 
the group name.
 



Options Menu
 
This menu contains the following commands:

a) Read Message
Select to read your messages.    Note:    In order for users to be able to read their messages, the program 
must identify a name(s) with workstations.    To do this, click on the name to be associated with that 
workstation and select My Name from the pop-up menu. The name will appear in the top title bar.    This 
procedure need never be repeated, unless a new user operates at that computer.    The  My Name 
command is password protected. See Password Access.

b) Add Name
Click on Add Name and type the name to be added.    Press Enter or OK  to enter the name or press 
Cancel to cancel the command. This command is password protected.    See Password Access.
 
c) Modify Remarks List
Click on Modify Remarks List to display the list of remarks. To add a new remark to the list, click on Add
and type a remark into the field displayed in the dialog box that pops up.    To remove a remark from the 
list, highlight the remark to be deleted and click on Remove.    After making the modifications, click on 
Close to save the changes and exit the window.

d) Shrink Window
Click on this to reduce the window to your preferred size.

e) Expand Window
Click on this to expand the window to your preferred size.

f) Yellow Hints
Click on this command to toggle the feature on and off.    When a tick mark appears on this menu item, 
then the yellow pop-up hints are activated.

g) Name Warning
Click on this command to toggle the feature on and off.    When a tick mark appears with this menu item, 
then the pop-up question window is activated.

h) Sign Out on Exit
Click on this command to toggle the feature on and off.    When a tick mark appears with this menu item, 
the program will automatically change your status from IN to OUT whenever you turn off your computer.
 



Help Menu
 
a) Contents 
Click on Contents to launch the on-line help system. 

b) Topic Search
Click on Topic Search  to search for on-line help for a subject.    

c) About
Select this item to display a window containing buttons for registration and ordering information.    It also 
contains program information (e.g., registration and serial numbers).
 



ADMINISTRATION
 
OfficeView has a security system (password) to control access to use the following commands: Add 
Name, Remove Name,  My Name, Change Password, Add New Group, Rename Group and Delete 
Group and to control access to make changes to the Additional Information screens for all employees.    
To allow access to make these changes, the Administrator(s) need only click on File/Admin Mode and 
enter a password.    To return to the normal mode of operation, click on File/User Mode.
 
To populate the board with user names, switch to Admin mode by clicking on File/Admin Mode.    Enter 
the password (initially="abc").    To enter each name, type Ctrl-N and the name. You can enter the 
information into the Additional Information screen for each name by clicking on their name and selecting 
Information.    Employees may prefer to enter this information for themselves after you identify their name
at their own workstation.

The program must identify names with workstations so that users can read their messages and make 
changes to the Additional Information screen at their workstations.    To do this, at the workstation, after a 
new name is added, click on the name to be associated with that workstation and select My Name from 
the pop-up menu. The name will appear in the top title bar.      You can read your messages only if your 
name appears in the title bar.    This procedure need never be repeated, unless a new user operates at 
that computer.
 
To change the admin password (initially="abc"), click on File/Change Password and enter the current 
password once, and    the new password twice.      The program will confirm that a new password has 
been accepted.    Passwords must consist of letters only.
 
Also see:
User Mode
Admin Mode
Change Password
Adding New Users
Associating a Name With a Workstation
Removing Users
Using Group OfficeView
 
 



INSTALLATION AND REMOVAL
 
If more than one workstation will be using the program, then a single copy of    the program must be 
installed on a shared directory.    This directory can be located on a fileserver or shared on a peer-to-peer 
LAN, such as Microsoft Networks or Lantastic.
 
OfficeView includes a Setup program to make installation very easy.    The Setup program can be used to 
install OfficeView on the common network directory and the individual workstations.
 
If you receive OfficeView in a compressed format, i.e., from the Internet or a CD library, then you will 
receive all the OfficeView files in one file with a name ending in .exe.
 
To extract and install OfficeView, click on the File menu of your Windows Program Manager, and select 
Run.  (Windows 95 users click Start/Run.) Type    the name of the compressed OfficeView file and click 
on OK.      Click on the Setup button to run the setup program.
 
If you are starting from a distribution diskette, use Program Manager’s File/Run or the Task Bar 
Start/Run. Type in A:SETUP.EXE and click on OK.
 
Un-installing OfficeView
 
The following steps outline how to completely remove the main copy of OfficeView (do all steps) and the 
LAN Workstations copies (do only first two steps):
 
- Delete the OfficeView group and OfficeView icon from the Program Manager.
- Delete ovlocal.ini from the main windows directory (usually c:\windows).
- Delete all files in the OfficeView directory ( default directory c:\OView ).
- Delete the OfficeView directory.
 
Answers to Questions:
If you have any questions, send them to phillips@capitalnet.com or officeview@ottawa.com.    In addition, 
the OfficeView web site at "www.capitalnet.com/~phillips" has a support page to assist you.



FEEDBACK AND UPGRADES 
 
We welcome any suggestions you have for improvements or upgrades or other information you may wish 
to communicate about this product.    Your comments will be considered in preparing any future upgrades. 
You may contact the author via e-mail at phillips@capitalnet.com or officeview@ottawa.com.
 
We are providing a five-name version of OfficeView for 10 or 30 users and a three-user in three groups 
version for the 300 or 1000 user programs free of charge. To increase the number of users, you must 
register your copy of OfficeView by purchasing the package, as outlined on the Order Form.
 
For the latest version, check our Internet Home Page at http://www.capitalnet.com/~phillips/.
 
 
 
 



Credit Card Orders
 
You can order with MC, Visa, Amex, or Discover from Public (Software) Library by:
 
-      calling 1-800-242-4775 Extension 15051 or 1-713-524-6394 Extension 15051; or
-        faxing the order form, including this page, to 713-524-6398; or
-        CIS e-mail to 71355,470@compuserve.com ; or
-        mailing credit card orders to PsL at P.O. Box 35705, Houston, TX    77235-5705; or
-        using the link at http://www.capitalnet.com/~phillips/ to access the Internet World Wide Web secure 
transaction ordering service.
 
If you mail or fax, be sure to type or print plainly and be sure to ask for product number 15051.
 
THE ABOVE NUMBERS ARE FOR CREDIT CARD ORDERS ONLY.    THE AUTHOR OF THIS 
PROGRAM (LEN PHILLIPS) CANNOT BE REACHED AT THESE NUMBERS.
 
Any question about the status of the shipment of the order, refunds, registration options, product details, 
technical support, volume discounts, dealer pricing, site licenses, non-credit card orders, etc., must be 
directed to Len Phillips at phillips@capitalnet.com or via the internet web site support page at 
http://www.capitalnet.com/~phillips/
 
 
 
Name: _______________________________________________________________
                          (first/middle)                                                                                        (last)
 
SHIP-TO ADDRESS
 
Company name: ________________________________________________________
 
Address:______________________________________________________________ 
 
City:_________________________________________________________________ 
 
State/Province:_________________________________________________________ 
 
Zip/Postal Code:________________________________________________________ 
 
Country:______________________________________________________________ 
 
Your e-mail address:_____________________________________________________ 
 
CREDIT CARD INFORMATION
 
Credit card start:____________________________
 
Expiration month:___________________________
 
Expiration year:_____________________________ 
 
 
Complete any of the following which is different from the above:
 
Name on the card:________________________________________________________
 



CREDIT CARD BILLING ADDRESS
 
Company name: _________________________________________________________
 
Address:_______________________________________________________________
 
City:__________________________________________________________________
 
State/Province:__________________________________________________________
 
Zip/Postal Code:_________________________________________________________
 
Country:_______________________________________________________________
 
 
 
 



ORDER FORM                     (use File, Topic Print to get a hard copy)
 
Payment by check or money order (payable to Len Phillips) and purchase orders may be sent directly to Len Phillips. 
Payment by credit card or by third party on-line secure web transaction is made via Public Software Library (PsL), 
Texas.    To make payment by credit card, refer to credit card orders. 
 
Purchase orders (net 30 days) are accepted only from government, accredited educational institutions and major 
corporations, provided they are submitted on purchase order forms with a purchase order number.    
 
Please mail this form with your payment or purchase order addressed to Len Phillips,    915 Plante Drive, Ottawa, 
Ontario, CANADA K1V 9E3. You may e-mail phillips@capitalnet.com for a fax number.
 
When you purchase this product, you will receive a diskette containing program files and an electronic version of the 
manual.    In case you do not want to wait to receive the mailed version, in addition, we will e-mail a registered version
to you.
 
OfficeView is shipped on 3.5 inch disks only.
 
 Size Unit Price    Quant.            Net
10 Name (16-bit)      $30.00 US _____ ________
10 Name (32-bit)      $30.00 US _____ ________
30 Name (16-bit)      $50.00 US    _____ ________
30 Name (32-bit)      $50.00 US      _____ ________
300 Name (16-bit)    $99.00 US    _____ ________
300 Name (32-bit)    $99.00 US      _____ ________
1000 Name (16-bit) $199.00 US      _____ ________
1000 Name (32-bit) $199.00 US _____ ________
    
        Ontario residents add 7% provincial sales tax ________
        Canadian residents add 8% GST                                      ________
        Shipping & handling add $5.00 ( U.S.)                      $5.00
 
                                                                                                              Total Payment ________
 
                                                                                                                                                  
Name: ____________________________________________________________________
 
Company: _________________________________________________________________
 
Address: __________________________________________________________________
 
City: ___________________________________ State/Province: ______________________
 
Zip/Postal Code: ______________________________ Country: _______________________
 
Phone No.:___________________________________ Fax No.:_______________________ 
 
E-Mail Address: _______________________________ P. O. No.:______________________
 
Comments: ________________________________________________________________
 
V 2.06    Jan 1 1997
 



Null
 
 
 



FINE PRINT (LEGAL DISCLAIMER)  
 
While every effort has been made to make this document as accurate and helpful as possible, Len 
Phillips makes no warranty of any kind with regard to its content.    All information included herein is 
subject to change without notice.    Len Phillips and any associates are not responsible for any loss or 
damages, direct or indirect, arising from or related to the use of this product.
 
All rights reserved.    Reproduction, adaptation or translation without prior written permission is prohibited, 
except as allowed under copyright laws.
 

 
 
 
 




